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What do
you want to
do?
Animation,
creating

How you do it in Powerpoint
2003

How you do it in Powerpoint 2007

Select Animations, Custom
Animations. See the rest of the
directions to the left for Powerpoint
2003.

Arrow
pointing to
something,
creating

To have words zoom in, peek in,
dissolve in, or use other effects,
select Custom Animation. Click
on the text box or words to
animate. Select Add Effect. To
have the words appear on a
mouse click, select Entrance and
then one of the effects. To have
the words appear larger or
disappear, select one of the
options below entrance. Motion
paths are a fancy way for the
letters to move.
Select arrow on the drawing
toolbar. Use the arrow to adjust
the angle, length, and change the
color of the arrow with the line
color on the drawing toolbar.

Select the arrow you want in the
drawing box. Use Shape Fill to change
the color of the arrow and Line Fill to
change the border of the arrow. Click
on the corners of the image to drag to
change the size or direction of the
arrow.
Select Page, Format,
The design tab allows you to select
Background, select a color from one of the standard backgrounds.
the row of recently used colors,
Select the box called Colors to the
or more colors. Point to the color right of the standard backgrounds.
desired on the hexagon. Apply to Click one, and then click on
the slide or to all slides. For
background styles. You’ll see different
different backgrounds, use one
backgrounds available in that color
of the fill effects. To use a
scheme.
picture as the background, select
Fill Effects, Picture, Select
Picture. Browse to the location
of the picture.
Insert, Text Box, Format, Text
Click the text box that you want to
Box, Color- select a color from
add a fill to. To add the same fill to
those displayed or pick more
multiple text boxes, click the first
colors.

Background
color,
adding to a
page

Background
color,
adding to a
text box
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text box, and then press and hold
SHIFT while you click the other
text boxes.
Under Drawing Tools, on the
Format tab, in the Shape Styles
group, click Shape Fill, and then
do one of the following: To add
or change a fill color, click the
color that you want, or to choose
no color, click No Fill.
To change to a color that is not
in the theme colors, click More
Fill Colors, and then either click
the color that you want on the
Standard tab, or mix your own
color on the Custom tab. Custom
colors and colors on the
Standard tab do not update if
you later change the document
these.
You can also adjust the
transparency of the text box by
clicking More Fill Colors. At the
bottom of the Colors dialog box,
move the Transparency slider, or
enter a number in the box next to
the slider. You can vary the
percentage of transparency from
0% (fully opaque, the default
setting) to 100% (fully
transparent).
To add or change a fill picture,
click Picture, locate and click
the picture that you want to use,
and then click Insert.
To add or change a fill gradient,
point to Gradient, and then click
the gradient variation that you
want.
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To customize the gradient, click
More Gradients, and then choose
the options that you want.
To add or change a fill texture,
point to Texture, and then click
the texture that you want.
To customize the texture, click
More Textures, and then choose
the options that you want.
Blanking the Hit B to turn the screen to black.
screen
Hit W to make the screen white.
This is useful when you want the
audience to focus on you and not
on the slide you just presented.
Blank slide, In slide sorter view, insert cursor
inserting
where desired slide should be
inserted. Select Insert, New
Slide.

Same

In slide sorter view, insert cursor
where desired slide should be inserted.
Right click, and select new.
Click on the slide view on the left side.
Hit CTRL and M. This will insert a
new slide.

Bullets,
adding

Click on the bullets icon. To add
color to bullets, select Format,
Bullets and Numbering, and then
color. Pick the color from the
hexagon.

Caps,
avoiding

Avoid all caps on slides. ALL
CAPS ARE DIFFICULT TO
READ
On the drawing toolbar, select
the circle. Place it around the
object to be highlighted. Select
fill effect. Click on the arrow

Circle
around
something,
creating

Go to Home, New Slide.
In the pane that contains the
Outline and Slides tabs, click a
slide thumbnail.
On the slide, select the lines of text
in a text placeholder or table that
you want to add bullets or
numbering to.
On the Home tab, in the Paragraph
group, click Bullets or Numbering.
Same

Select the circle in the drawing section
of the toolbar. Hold your cursor down
to adjust the size of the circle. Select
Shape Fill, No Fill to get an empty
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next to fill effect, and select no
fill to have a clear circle. The
Line Color can be used to color
the rectangle. Line Style is used
to adjust the thickness of the
lines making up the rectangle.
Select the font type and size in
the toolbar. Use san serif fonts
(without curls on letters.) Arial is
a san serif font. Avoid using
anything smaller than a size 32
on slides. Ideal sizes are 36-40.
After composing a slide with
text, take ten steps away from
the monitor. If you can read the
slide, it is large enough to
project in a room.
1. If a headline or title of a slide
is partially covered by a photo,
right click on the photo. On the
shortcut menu, click order, Send
to Back.

circle. Use Shape Outline to change
the floor of the circle outline.
Experiment with Shape Effects to
change the way the circle looks.

Home, Font. The rest is the same.

Use a light background for ease of
viewing letters.

1. If a headline or title of a slide is
partially covered by a photo, right
click on the photo. In the Format,
2. Change the color of the font to Arrange tab, click Send To Back.
a different color to improve
2. Change the color of the font to a
legibility. Hold down shift key
and click on the title area. Click different color to improve legibility.
Hold down shift key and click on the
the font color button on the
title area. Click the font color button
formatting toolbar. In the drop
on the Home toolbar. In the drop down
down list, select the color.
list, select the color.
3. Use bold.
3. Add a rectangle below the title area.
On the drawing toolbar, click the
4. Add a transparent rectangle
rectangle button. Click and drag to
below the title area. On the
create a rectangle. Use the sizing
drawing toolbar, click the
rectangle button. Click and drag handles to adjust the size.
Click on the Shapes Style toolbar to
to create a rectangle that covers
adjust the appearance of the box. Click
the entire title area. Use the
sizing handles to adjust. Double on the right down arrow to see the
options.
click the rectangle to open the
format autoshape dialog box,
and in the line section of the
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colors and lines tab, click the
color drop down arrow and click
no line. In the fill section, click
the color drop down arrow, click
fill effects. In the fill effects
dialog box, click the gradient
tab. In the color section, select
two colors, and set both color 1
and color 2 to black. In the
transparency section, leave the
“from” slider at 0%. Drag the
“to” slider to 100%. In the
shading styles section, click
vertical. Click OK to close the
fill effects dialog box and then
click OK to close the format
autoshape dialog box.

Labels,
inserting

Margins

Navigating
between
slides

Right click on the rectangle, and
on the shortcut menu, click
Order, Send To Back. Then right
click the photograph, and on the
shortcut menu, click Order, Send
To Back. The title area should
now be in the top layer.
On the drawing toolbar, click
autoshapes, callouts. Click on
the style you want. After adding
the label to the slide, modify it
by adding text and adjusting the
format.
Use the handles on photographs
that are inserted into a slide to
keep the margins to one inch all
around. This will permit the
slides to print with images
visible, and will reduce the risks
associated with using LCD
projectors that cut off part of the
image.
Use the page up or page down,
arrow up or arrow down keys on
the keyboard.

On the home page, look at the shapes
in the drawing toolbar. Click on the
down arrow next to the first set of
shapes to see more.

Same

Same
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View, Notes Page. Click on
bottom rectangle to add notes.
You can reduce the font to get
more notes on a page.
To print Notes Pages, go to
Print, Print What and select
Notes Pages.
Pack and Go Pack and Go permits you to play
your presentation on a computer
that does not have Powerpoint
on it (or your version of
Powerpoint). Select File/Pack
and Go. Click OK. Select your
presentation and choose the
destination for the packed file,
such as a thumb drive or CD.
Choose to include linked files
and fonts. Choose to include
Powerpoint Viewer.

How you do it in Powerpoint 2007

Go to Home, View, Notes page.

Open the presentation that you
want to copy, or, if you are
working with a new presentation
that has not been saved, save the
presentation.
Do one of the following:
If you are copying your
presentation to a CD, insert a
CD into the CD drive.
You can copy to a blank
recordable CD (CD-R), a
blank rewritable CD (CDRW), or a CD-RW that
To unpack, put your CD or
contains existing content that
thumb drive in the laptop.
can be overwritten.
Double click on Pngsetup icon
on the CD or thumb drive.
In PowerPoint, if you copy
Specify where to put the
your presentation to a CD,
unpacked file (usually the
make sure that you copy all of
laptop’s desktop.) Click OK. The the files in a single operation.
file will copy onto the desktop.
After the first set of files is
copied, you cannot add any
more files to the disc by using
PowerPoint. However, you
can use Windows Explorer to
copy additional files to a CDR or CD-RW that contains
existing files.
On the Microsoft Office Button,
point to the arrow next to Publish,
and then click Package for CD.
In the Package for CD dialog box,
in the Name the CD box, type a
name for the CD or the folder that
you want to copy your presentation
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to.
To choose the presentations that
you want to copy and the order in
which you want them to play, do
the following:
To add a presentation, click Add
Files, select the presentation that
you want to add, and then click
Add. Repeat this step for each
presentation that you want to
add.
If you want to add other related,
non-PowerPoint files in the
package, you can. These files
will be copied, but Office
PowerPoint Viewer 2007 will
not play them.
If you add more than one
presentation, the presentations
will play in the order in which
they are listed in the Files to be
copied list. To change the order,
select a presentation that you
want to move, and then click the
arrow buttons to move the
presentation up or down in the
list.
The presentation that is currently
open automatically appears in
the Files to be copied list. Files
that that you linked to the
presentation are included
automatically, but they do not
appear in the Files to be copied
list.
To remove a presentation or file
from the Files to be copied list,
select the presentation or file,
and then click Remove.
Click Options.
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Under Package type, do one of the
following:
To specify how a presentation
will play in the PowerPoint
Viewer, click Viewer Package
(update file formats to run in
PowerPoint Viewer), and then
select an option in the Select
how presentations will play in
the viewer list.
To make a package that you are
certain viewers will view on a
computer that has PowerPoint or
PowerPoint Viewer installed,
click Archive Package (do not
update file formats).
Use this option when you want
to package an Extensible
Markup Language (Extensible
Markup Language (XML): A
condensed form of Standard
Generalized Markup Language
(SGML) that enables developers
to create customized tags that
offer flexibility in organizing
and presenting information.)
presentation (and files linked to
it) in its original file format to
preserve fidelity and quality
without saving it as a binary file
format.
Under Include these files, do one
or both of the following:
To ensure that files that are
linked to your presentation are
included in the package, select
the Linked files check box. Files
that are linked to your
presentation can include
Microsoft Office Excel
worksheets that are linked to
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charts, sound files, movie clips,
and more.
Click OK to close the Options
dialog box.
Do one of the following:
If you are copying your
presentation to a network or to a
local disk drive on your
computer, click Copy to Folder,
enter a folder name and location,
and then click OK.
If you are copying your
presentation to a CD, click Copy
to CD.
Photo or
object,
inserting

Insert picture from file. Browse
to the location of the image to be
used.

Insert, Picture, and then browse to the
location of the image. Go to Format,
Picture Styles, to adjust the appearance
of the picture. Select any of the effects
by clicking on the sample in the
toolbar to see what happens.

Picture,
cropping

Display the Picture toolbar by
clicking view, toolbars and
selecting picture. Click the
photo, and on the picture toolbar,
click the crop button. Cropping
handles will appear. Drag the
handles until the picture is the
size you desire.

Select the picture that you want to
crop.
Under Picture Tools, on the Format
tab, in the Size group, click Crop.
If you do not see the Picture Tools
and Format tabs, make sure that
you selected a picture.
Do one of the following:
To crop one side, drag the center
cropping handle on that side
inward.
To crop equally on two sides at
once, press and hold CTRL
while you drag the center
cropping handle on either side
inward.
To crop equally on all four sides
at once, press and hold CTRL
while you drag a corner
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cropping handle inward.
To crop your picture to exact
dimensions, do the following:
Under Picture Tools, on the
Format tab, in the Size group,
click the Dialog Box Launcher.
On the Size tab, under Crop
from, enter the size numbers that
you want in the Left, Right, Top,
and Bottom boxes.
To reduce the file size of your
picture and delete the cropped
parts of the picture from the file,
under Picture Tools, on the Format
tab, in the Adjust group, click
Compress Pictures. If you want to
keep the cropped parts, you can
change the automatic setting.
To undo a crop before you save
your document, click Reset Picture
in the Adjust group or Undo
on
the Quick Access Toolbar.
Pictures,
compressing

To compress a single photo,
select it and on the Picture
toolbar, click the compress
pictures button. In the compress
pictures dialog box, click the
change resolution button next to
Web/Screen.
To compress all of the pictures
in your presentation at one time,
click the “apply to” button next
to all pictures in document.
When you’ve made your
selections, click OK. If the
picture toolbar is not showing,
go to view and activate picture
toolbar by clicking on it. Select
icon that looks like a square with

To compress a single photo, click on
it. In the Picture toolbar, click on the
Compress Photos (in the upper left).
Place a check box in the message
“Apply to selected picture only.”
To compress all pictures in the
presentation at one time, leave the
check box in the message box blank.
Go to the Options button and
determine the resolution you desire:
print, screen or email.
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arrows pointing at four corners.
Use no more than 6 lines of text,
and no more than 6 words per
line. Use a minimum of 32 font.
Reuse slides Insert, Slide From File, Browse,
from
and then locate the slide show.
another
Click on the slides to be inserted.
presentation If you want the background to be
carried over, click on keep
source formatting. Be careful to
deselect the pictures after they
are inserted, otherwise all will be
reinserted each time you skip
ahead to another slide.
Screen saver Turn off the screen saver to
avoid the risk of the screen saver
popping on at inopportune times.
Go to control panel in Windows
(access through the Start button
in the lower left corner of the
screen) or an icon on the
desktop, display, screen saver,
and change the timing.
Slide master Click on the title box at the top
of the slide and click Format.
Click Font. Under the Size pull
down menu, choose 40
(Choosing a 40 point type size in
your Slide Master allows you to
clearly see and read the
headlines in your presentation
from this view).Click OK.
Readability

With the title box still selected,
click Format | Placeholder and
choose the Text Box tab in the
dialog box. Select Top from the
pull down menu. Click OK.
With the title box still selected,
click Format | Alignment and
from the pull down menu and
choose Align Left. Click on the
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Same

Go to Home, New Slide. At the
bottom of the box, select Reuse Slides.
Select browse file. Browse to the file
on your computer that has the slide
you want to reuse. The slides will be
displayed. Click on the one you want
to reuse. It will be inserted into your
new presentation.

Same, may vary with your version of
Windows

For each slide master that you want to
create, do the following:
Open a blank presentation, and
then, on the View tab, in the
Presentation Views group, click
Slide Master.
When you open Slide Master view,
a blank slide-master with the
default, associated layouts appears.
If you want to add another slide
master, do the following:
Click a location in the slide
thumbnail (thumbnail: A
miniature representation of a
picture) pane where you want
the new slide master to appear.
On the Slide Master tab, in the
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Close Master View button to
return back to your slides.

Edit Master group, click Insert
Slide Master.

Click View | Slide Sorter to see
your new PowerPoint
storyboard. From Slide Sorter
view click Edit | Select All

In the slide thumbnail pane, the
slide master is the larger slide
image, and the associated layouts
are positioned beneath the slide
master.

Click Format | Slide Layout and
click “Title and Content”. This
sets up all of your slides with a
title at the top of the slide and a
visual element below.

To create one or more custom
layouts or to modify existing
layouts, see Create a new custom
layout.
To add or modify placeholders in
your layouts, see Add one or more
content placeholders to a layout or
Change a placeholder.
To remove any of the built-in slide
layouts that accompany the default
slide master, in the slide thumbnail
pane, right-click each slide layout
that you want to delete, and then
click Delete Layout on the shortcut
menu (shortcut menu: A menu that
shows a list of commands relevant
to a particular item. To display a
shortcut menu, right-click an item
or press SHIFT+F10.).
To apply a design or theme (theme:
A combination of theme colors,
theme fonts, and theme effects. A
theme may be applied to a file as a
single selection.)-based colors,
fonts, effects and backgrounds.
To set the page orientation for all
of the slides in your presentation,
on the Slide Master tab, in the Page
Setup group, click Slide
Orientation, and then click either
Portrait or Landscape.
To add text that will appear as a
footer at the bottom of all of the
pages in your presentation, do the
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following:
On the Insert tab, in the Text
group, click Header & Footer.
In the Header and Footer dialog
box, on the Slide tab, select the
Footer check box, and then type
the text that you want to appear
in the center-bottom of your
slides.
Click Apply to All.
Click the Microsoft Office
, and then click Save As.
Button
In the File name box, type a file
name, or do nothing to accept the
suggested file name.
In the Save as type list, click
PowerPoint Template, and then
click Save.
On the Slide Master tab, in the
Close group, click Close Master
View.
Slide order,
rearranging

Slides,
printing as
handouts

Slide
transition,
creating

In slide sorter view, click on the
slide to be moved. Hold the
button down and drag it to
desired location.
To print slides, go to Print, Print
What, and pick Handouts.
Determine how many slides you
want per page and whether you
want them in color or greyscale.
Select Slide Show, Slide
Transition, and one of the
effects. In slide sorter view, click
Edit, Select All. Click Slide
Show, Slide Transition. In the
slide transition panel, in the
“apply to selected slide”, select a
subtle transition such as fade
smoothly or fade through to
black. In the modify transition

Same

Same

Go to the Animations toolbar. Select
the effect you want. Click on the down
arrow next to the choices to see more.
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section next to speed, click on
Speed in the drop down list. In
the Advance Slide Section,
select On The Mouse Click if
you want to manually advance
the slides.
In Slide Sorter View, click on
the slide to be copied. Edit,
Copy. Then place the slide
where you wish it to go, click
view, paste.
Slide Show, Slide Transition,
advance slide automatically
after- fill in the number of
seconds. Apply to all slides if
you wish the timing to be
uniform.
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Same

On the Slide Show tab, in the Set
Up group, click Rehearse Timings.
The Rehearsal toolbar appears, and
the Slide Time box begins timing
the presentation.

Next (advance to next slide)
Pause
Slide Time
Repeat
Total time for presentation
While you time your presentation,
do one or more of the following on
the Rehearsal toolbar:
To move to the next slide, click
Next.
To temporarily stop recording
the time, click Pause.
To restart recording the time
after pausing, click Pause.
To restart recording the time for
the current slide, click Repeat.

What do
you want to
do?

How you do it in Powerpoint
2003

How you do it in Powerpoint 2007

After you set the time for the last
slide, a message box displays the
total time for the presentation and
prompts you to do one of the
following:
To keep the recorded slide
timings, click Yes.
To discard the recorded slide
timings, click No.
Slide Sorter view appears and
displays the time of each slide in
your presentation.
Titles of
slides

Video,
inserting

This technique enables you to
create a whole set of slides
without having to insert each
title one at a time. In a Word
document, type one headline per
line. All should be flush left.
Click file, send to, and click
Microsoft Office Powerpoint. A
series of new Powerpoint slides
is created. A new statement is
placed in the title area of its own
slide. Click file, save, name the
file, and save it.

On the placeholder icon, chose
insert Sound/Movie. Choose
how to play- automatically or by
mouse click.

To import word document into
PowerPoint 2007:
1. Open your saved Word document
2. Click on office button> word
option >customize
3. Select all command under choose
command from
4. Select send to Microsoft office
PowerPoint
5. Click on add and then click on ok
6. In Quick Access toolbar click on
sent to office PowerPoint
7. It will send your word document
into PowerPoint
8. Press F5 from your keyboard and
it will run slideshow in your
PowerPoint
Insert, Movie, and browse to the
location of the video. Large files are
not stored in PowerPoint. They are
linked. Bring a pen/thumb drive with
you with the files. You may have to
relink to the files if you move your
presentation to a thumb drive.
If the video will not play, you may
have to cycle through the input source
(use the function key + CRT key) until
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there is nothing showing on the laptop
and the video placeholder is showing
on the big screen created by the LCD
projector. If you try to show the video
on the screen and the computer, you
may run out of memory and nothing
will play. Wait until the cursor
changes to a hand. One click starts the
video. The second click pauses it.
Same

Keep wording consistent. For
example, start all bullet point
items with the same format, such
as locating, presenting,
attending, etc. Avoid lengthy
sentences. If a line has to word
wrap, it may be too long.
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